ProQuest 360 Core Accessibility Conformance Report

International Edition
(Based on VPAT® Version 2.4)
Name of Product/Version:
360 Core

Report Date:

December 11, 2020

Product Description:

360 Core is a solution for libraries seeking a set of foundational access, management, and assessment services to improve workflows and reduce
workloads. An entry-level option to automate and centralize e-resource management, 360 Core provides tools for collection control and easy
access to e-resources.

Contact Information:

https://support.proquest.com/submitcase

Notes:

ProQuest is committed to providing all our users with a fully accessible experience for research, teaching and learning.

“Voluntary Product Accessibility Template” and “VPAT” are registered
service marks of the Information Technology Industry Council (ITl) Page 1 of 40
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The following parts of 360 Core have been evaluated as part of this report

e Management Tools
e Overlap Analysis
e Management Reports

Evaluation Methods Used:

e Color Contrast Analyzer

e Deque aXe accessibility testing tool

e High Contrast Chrome extension

e Keyboard-access manual testing and assessment

e NVDA (NonVisual Desktop Access) screen-reader utility

e WebAim’s WAVE (Web Accessibility Evaluation tool)

Applicable Standards/Guidelines

This report covers the degree of conformance for the following accessibility standard/guidelines:

Standard/Guideline
Web Content Accessibility Guidelines 2.0

Web Content Accessibility Guidelines 2.1

Revised Section 508 standards published January 18, 2017 and corrected January 22,
2018
EN 301 549 Accessibility requirements suitable for public procurement of ICT

products and services in Europe, - V3.1.1 (2019-11)
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Included In Report
Level A (Yes)

Level AA (Yes)
Level AAA (No)
Level A (Yes)
Level AA (Yes)
Level AAA (No)

(Yes)

(No)


http://www.w3.org/TR/2008/REC-WCAG20-20081211
https://www.w3.org/TR/WCAG21
https://www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-ict-refresh/final-rule/text-of-the-standards-and-guidelines
https://www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-ict-refresh/final-rule/text-of-the-standards-and-guidelines
https://www.etsi.org/deliver/etsi_en/301500_301599/301549/03.01.01_60/en_301549v030101p.pdf
https://www.etsi.org/deliver/etsi_en/301500_301599/301549/03.01.01_60/en_301549v030101p.pdf

Terms

The terms used in the Conformance Level information are defined as follows:

e Supports: The functionality of the product has at least one method that meets the criterion without known defects or meets with
equivalent facilitation.

Partially Supports: Some functionality of the product does not meet the criterion.

Does Not Support: The majority of product functionality does not meet the criterion.

Not Applicable: The criterion is not relevant to the product.

Not Evaluated: The product has not been evaluated against the criterion. This can be used only in WCAG 2.0 Level AAA.

WCAG 2.x Report

Tables 1 and 2 also document conformance with:

e EN 301 549: Chapter 9 - Web, Sections 10.1-10.4 of Chapter 10 - Non-Web documents, and Sections 11.1-11.4 and 11.8.2 of
Chapter 11 - Non-Web Software (open and closed functionality), and Sections 12.1.2 and 12.2.4 of Chapter 12 — Documentation

¢ Revised Section 508: Chapter 5 — 501.1 Scope, 504.2 Content Creation or Editing, and Chapter 6 — 602.3 Electronic Support
Documentation.

Note: When reporting on conformance with the WCAG 2.x Success Criteria, they are scoped for full pages, complete processes, and
accessibility-supported ways of using technology as documented in the WCAG 2.0 Conformance Requirements.
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https://www.w3.org/TR/WCAG20/#conformance-reqs

Table 1: Success Criteria, Level A

Criteria
1.1.1 Non-text Content (Level A)

Also applies to:

EN 301 549 Criteria
e 9.1.1.1(Web)
e 10.1.1.1 (Non-web document)
e 11.1.1.1.1 (Open Functionality Software)
e 11.1.1.1.2 (Closed Functionality Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)

Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

Conformance Level
Partially Supports
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Remarks and Explanations
Software is designed to support alternative access to
non-text content wherever possible. Images used to
represent functionality or actions have associated text
labels (or alt /title text if a text label is not appropriate).

Decorative images have blank alt text, so they will be
ignored by assistive technology.

Compliance of this standard was validated with NVDA
with Firefox

Exceptions
e The following controls have insufficient
labelling:

ExLibris logo image in the banner
e Current library Change link in the banner e-
Catalog search controls

Data Management area

e Filter By dropdown on pages with tables

e Pagination control specifying a page to go to

e Table heading indicators of sort order on Data
Management page

e Data Management > New > Input fields -
dropdowns on New Library Specific Database
page

e Data Management > Edit > Library Databases -
dropdown (Subscribed, Under Review...) to
update status is not labeled

e Data Management > Databased Details — links

e Data Management > Databased Details > Edit >
Database details edit form — input fields and
other controls


http://www.w3.org/TR/WCAG20/#text-equiv-all

Criteria

1.2.1 Audio-only and Video-only (Prerecorded) (Level A)

Also applies to:
EN 301 549 Criteria

9.1.2.1 (Web)

10.1.2.1 (Non-web document)

11.1.2.1.1 (Open Functionality Software)
11.1.2.1.2.1 and 11.1.2.1.2.2 (Closed Software)
11.8.2 (Authoring Tool)

12.1.2 (Product Docs)

12.2.4 (Support Docs)

Revised Section 508

501 (Web)(Software)
504.2 (Authoring Tool)
602.3 (Support Docs)

1.2.2 Captions (Prerecorded) (Level A)

Also applies to:
EN 301 549 Criteria

9.1.2.2 (Web)

Conformance Level

Not Applicable

Not Applicable
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Remarks and Explanations

e Provider Details — input fields and other
controls

Knowledge Base Notifications
e Active notifications > Edit — complete
checkbox and note input fields

Overlap Analysis
e Add Databases — Search by fields
e Add/Remove Databases table — checkboxes

Knowledgebase Notifications
e Active Notifications footer and header
e Spacing images on sides of table
e Notes text box in table

There are no audio or video captions

There are no audio or video captions


http://www.w3.org/TR/WCAG20/#media-equiv-av-only-alt
http://www.w3.org/TR/WCAG20/#media-equiv-captions

Criteria Conformance Level Remarks and Explanations

e 10.1.2.2 (Non-web document)
e 11.1.2.2 (Open Functionality Software)
e 11.1.2.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
1.2.3 Audio Description or Media Alternative (Prerecorded) (Level A) Not Applicable There are no audio or video captions
Also applies to:
EN 301 549 Criteria
e 9.1.2.3(Web)
e 10.1.2.3 (Non-web document)
e 11.1.2.3.1 (Open Functionality Software)
e 11.1.2.3.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

1.3.1 Info and Relationships (Level A) Partially supports The site employs the following to support this:

Also applies to:

EN 301 549 Criteria e labels/ids with form elements
e 9.1.3.1(Web) e markup for lists & headings
e 10.1.3.1 (Non-web document) e CSSto control the visual presentation of text
e 11.1.3.1.1 (Open Functionality Software) e Correct use of semantic markup (bold, italics,
e 11.1.3.1.2 (Closed Software) etc.)
e 11.8.2 (Authoring Tool) Compliance of this standard was validated by WAVE
e 12.1.2 (Product Docs) (web accessibility evaluation tool) provided by WebAIM,

e 12.2.4 (Support Docs)
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http://www.w3.org/TR/WCAG20/#media-equiv-audio-desc
http://www.w3.org/TR/WCAG20/#content-structure-separation-programmatic

Criteria
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

1.3.2 Meaningful Sequence (Level A)

Also applies to:

EN 301 549 Criteria
e 9.1.3.2 (Web)
e 10.1.3.2 (Non-web document)
e 11.1.3.2.1 (Open Functionality Software)
e 11.1.3.2.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)

Conformance Level

Supports
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Remarks and Explanations
manual visual checks, screenreader, and code
inspection

Exceptions

Top banner (Your account, Knowledge center...) is not
identified as a banner region

Data Management

Table filtering in is not identified as a group of controls
Database details filter (General, Title,...) is not identified
as a group of controls

Data Summary
Headings are not using semantic markup

Overlap Analysis

Table filtering is not identified as a group of controls
Details filter (General, Title,...) is not identified as a
group of controls

Management Reports
Select reports controls are not identified as a group and
not labelled

Compliance of this standard was validated using a
combination of screen readers (see list in the Notes
above) and manual keyboard and visual checks.


http://www.w3.org/TR/WCAG20/#content-structure-separation-sequence

Criteria

e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
1.3.3 Sensory Characteristics (Level A)
Also applies to:
EN 301 549 Criteria
e 9.1.3.3 (Web)
e 10.1.3.3 (Non-web document)
e 11.1.3.3 (Open Functionality Software)
e 11.1.3.3 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
1.4.1 Use of Color (Level A)
Also applies to:
EN 301 549 Criteria
e 9.1.4.1(Web)
e 10.1.4.1 (Non-web document)
e 11.1.4.1 (Open Functionality Software)
e 11.1.4.1 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
1.4.2 Audio Control (Level A)

Conformance Level

Supports

Supports

Not Applicable
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Remarks and Explanations

Instructions provided do not rely solely on sensory
characteristics of components such as shape, size, visual
location, orientation, or sound. Typically, descriptive
text and labels are used.

Compliance of this standard was validated using manual
visual checks.

Color is used to enhance usability by drawing attention
to certain areas of the screen.

Color is never the only means of conveying information,
indicating an action, prompting a response, or
distinguishing a visual element.

Compliance of this standard was validated using manual
visual checks and WAVE.

There is no audio content


http://www.w3.org/TR/WCAG20/#content-structure-separation-understanding
http://www.w3.org/TR/WCAG20/#visual-audio-contrast-without-color
http://www.w3.org/TR/WCAG20/#visual-audio-contrast-dis-audio

Criteria
Also applies to:
EN 301 549 Criteria
e 9.1.4.2(Web)
e 10.1.4.2 (Non-web document)
e 11.1.4.2 (Open Functionality Software)
e 11.1.4.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
2.1.1 Keyboard (Level A)
Also applies to:
EN 301 549 Criteria
e 9.2.1.1(Web)
e 10.2.1.1 (Non-web document)
e 11.2.1.1.1 (Open Functionality Software)
e 11.2.1.1.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

2.1.2 No Keyboard Trap (Level A)
Also applies to:
EN 301 549 Criteria
e 9.2.1.2(Web)
e 10.2.1.2 (Non-web document)
e 11.2.1.2 (Open Functionality Software)
e 11.2.1.2 (Closed Software)

Conformance Level

Partially Supports

Supports
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Remarks and Explanations

This product is designed for keyboard access. Product
functionality is available and executable from a
keyboard.

Exceptions

Overlap Analysis
e Select Databases To Analyze > Edit Default List >
Default status list is not editable with keyboard
only. It only supports drag and drop.

Knowledgebase Notifications

e Check boxes in "Complete" column of table are
not keyboard accessible, must use a mouse.

Focus can be moved to and away from components
using only a keyboard.

Compliance of this standard was validated using manual
keyboard checks.


http://www.w3.org/TR/WCAG20/#keyboard-operation-keyboard-operable
http://www.w3.org/TR/WCAG20/#keyboard-operation-trapping

Criteria Conformance Level
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
2.1.4 Character Key Shortcuts (Level A 2.1 only) Not Applicable
Also applies to:
EN 301 549 Criteria
e 9.2.1.4 (Web)
e 10.2.1.4 (Non-web document)
e 11.2.1.4.1 (Open Functionality Software)
e 11.2.1.4.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508 — Does not apply
2.2.1 Timing Adjustable (Level A) Not Applicable
Also applies to:
EN 301 549 Criteria
e 9.2.2.1(Web)
e 10.2.2.1 (Non-web document)
e 11.2.2.1 (Open Functionality Software)
e 11.2.2.1 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
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Remarks and Explanations

This site does not have character key shortcuts.

This site does not require timed responses.


https://www.w3.org/TR/WCAG21/#character-key-shortcuts
http://www.w3.org/TR/WCAG20/#time-limits-required-behaviors

Criteria
2.2.2 Pause, Stop, Hide (Level A)
Also applies to:
EN 301 549 Criteria
e 9.2.2.2 (Web)
e 10.2.2.2 (Non-web document)
e 11.2.2.2 (Open Functionality Software)
e 11.2.2.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
2.3.1 Three Flashes or Below Threshold (Level A)
Also applies to:
EN 301 549 Criteria
e 9.2.3.1(Web)
e 10.2.3.1 (Non-web document)
e 11.2.3.1 (Open Functionality Software)
e 11.2.3.1 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
2.4.1 Bypass Blocks (Level A)
Also applies to:
EN 301 549 Criteria
e 9.2.4.1(Web)

e 10.2.4.1 (Non-web document) — Does not apply
e 11.2.4.1 (Open Functionality Software) — Does not apply

Conformance Level
Not Applicable

Not Applicable

Does Not Support
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Remarks and Explanations
There is no moving, blinking, scrolling, or auto-updating
content on the site.

Compliance of this standard was validated using manual
visual checks.

There are not flashing or blinking elements in the user
interface.

Verified using a keyboard and a screen reader

Top navigation and left filters cannot be skipped
Example: Databased Details — left navigation (titles,
books, ...)


http://www.w3.org/TR/WCAG20/#time-limits-pause
http://www.w3.org/TR/WCAG20/#seizure-does-not-violate
http://www.w3.org/TR/WCAG20/#navigation-mechanisms-skip

Criteria Conformance Level Remarks and Explanations

e 11.2.4.1 (Closed Software) — Does not apply

e 11.8.2 (Authoring Tool)

e 12.1.2 (Product Docs)

e 12.2.4 (Support Docs)
Revised Section 508

e 501 (Web)(Software) — Does not apply to non-web software

e 504.2 (Authoring Tool)

e 602.3 (Support Docs) — Does not apply to non-web docs

2.4.2 Page Titled (Level A) Does Not Support Most page titles have tagged titles but the titles are very

Also applies to: generic (ExLibris | Client Center)
EN 301 549 Criteria

e 9.24.2 (Web)

e 10.2.4.2 (Non-web document)

e 11.2.4.2 (Open Functionality Software) - Does not apply

e 11.2.4.2 (Closed Software) — Does not apply

e 11.8.2 (Authoring Tool)

e 12.1.2 (Product Docs)

e 12.2.4 (Support Docs)
Revised Section 508

e 501 (Web)(Software)

e 504.2 (Authoring Tool)

e 602.3 (Support Docs)

2.4.3 Focus Order (Level A) Partially Supports Page elements and functionality are placed in an order
Also applies to: that follows the sequences and relationships in the
EN 301 549 Criteria content.
e 9.2.4.3(Web)
e 10.2.4.3 (Non-web document) Compliance of this standard was validated using manual
e 11.2.4.3 (Open Functionality Software) keyboard checks.
e 11.2.4.3 (Closed Software)
e 11.8.2 (Authoring Tool) Exceptions
e 12.1.2 (Product Docs) e After applying filters to data, focus is placed at
e 12.2.4 (Support Docs) the top of the screen.

Revised Section 508
e 501 (Web)(Software)
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http://www.w3.org/TR/WCAG20/#navigation-mechanisms-title
http://www.w3.org/TR/WCAG20/#navigation-mechanisms-focus-order

Criteria

e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

2.4.4 Link Purpose (In Context) (Level A)
Also applies to:
EN 301 549 Criteria
e 9.2.4.4(Web)
e 10.2.4.4 (Non-web document)
e 11.2.4.4 (Open Functionality Software)
e 11.2.4.4 (Closed Software
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

2.5.1 Pointer Gestures (Level A 2.1 only)
Also applies to:
EN 301 549 Criteria
e 9.2.5.1(Web)
e 10.2.5.1 (Non-web document)
e 11.2.5.1 (Open Functionality Software)
e 11.2.5.1 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508 — Does not apply
2.5.2 Pointer Cancellation (Level A 2.1 only)
Also applies to:
EN 301 549 Criteria
e 9.2.5.2 (Web)
e 10.2.5.2 (Non-web document)

Conformance Level

Partially Supports

Not Applicable

Supports
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Remarks and Explanations

e Examples: Data Management > Library
Databases — after filtering databases, the focus
is placed at the top of the page.

Meaningful link text has been used throughout.

Compliance of this standard was validated using manual
keyboard checks.

Exceptions

e Change Current Library link is ambiguous

Management Reports

e Download report links are ambiguous

Data Management

e Databased details links are not labeled properly

This site has no mulitpoint or path-based gestures.

Interactions are executed on the Up action of buttons
and links.

Compliance of this standard was validated using manual
checks.


http://www.w3.org/TR/WCAG20/#navigation-mechanisms-refs
https://www.w3.org/TR/WCAG21/#pointer-gestures
https://www.w3.org/TR/WCAG21/#pointer-cancellation

Criteria

e 11.2.5.2 (Open Functionality Software)
e 11.2.5.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)

Revised Section 508 — Does not apply

2.5.3 Label in Name (Level A 2.1 only)

Also applies to:

EN 301 549 Criteria
e 9.2.5.3(Web)
e 10.2.5.3 (Non-web document)
e 11.2.5.3.1 (Open Functionality Software)
e 11.2.5.3.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)

Revised Section 508 — Does not apply

2.5.4 Motion Actuation (Level A 2.1 only)
Also applies to:
EN 301 549 Criteria

Conformance Level

Partially Supports

Not Applicable

Page 14 of 40

Remarks and Explanations

Compliance of this standard was validated using manual
visual checks.

Accessible names are present on form elements and
match the visible labels.

Exceptions:
e-Catalog widgets are missing accessible names

Management Tools

e “Filter By: Name Begins With” dropdown menu
and text box

e “Got To Page:” text box

e Data Management>New Library Specific
Database all of the form's text box fields

e Data Management>Edit Status table filtering
dropdown menu

Knowledgebase Notifications

e Checkboxes in “Complete” column of table.

Management Reports

e "Select Report:" drop down menu
e "Report Name" text box

Content does not require motion controls or physical
gestures to access content or functionality.


https://www.w3.org/TR/WCAG21/#label-in-name
https://www.w3.org/TR/WCAG21/#motion-actuation

Criteria

9.2.5.4 (Web)

10.2.5.4 (Non-web document)
11.2.5.4 (Open Functionality Software)
11.2.5.4 (Closed Software)

11.8.2 (Authoring Tool)

12.1.2 (Product Docs)

12.2.4 (Support Docs)

Revised Section 508 — Does not apply
3.1.1 Language of Page (Level A)

Also applies to:
EN 301 549 Criteria

9.3.1.1 (Web)

10.3.1.1 (Non-web document)
11.3.1.1.1 (Open Functionality Software)
11.3.1.1.2 (Closed Software)

11.8.2 (Authoring Tool)

12.1.2 (Product Docs)

12.2.4 (Support Docs)

Revised Section 508

501 (Web)(Software)
504.2 (Authoring Tool)
602.3 (Support Docs)

3.2.1 On Focus (Level A)
Also applies to:
EN 301 549 Criteria

9.3.2.1 (Web)

10.3.2.1 (Non-web document)
11.3.2.1 (Open Functionality Software)
11.3.2.1 (Closed Software)

11.8.2 (Authoring Tool)

12.1.2 (Product Docs)

12.2.4 (Support Docs)

Revised Section 508

501 (Web)(Software)

Conformance Level Remarks and Explanations

Does Not Support Document lacks language attribute

Verified using browser code inspection

Supports Context is not changed on focus alone.

Compliance of this standard was validated using manual
keyboard checks.
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http://www.w3.org/TR/WCAG20/#meaning-doc-lang-id
http://www.w3.org/TR/WCAG20/#consistent-behavior-receive-focus

Criteria

e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
3.2.2 On Input (Level A)

Also applies to:

EN 301 549 Criteria
e 9.3.2.2 (Web)
e 10.3.2.2 (Non-web document)
e 11.3.2.2 (Open Functionality Software)
e 11.3.2.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)

Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

3.3.1 Error Identification (Level A)

Also applies to:

EN 301 549 Criteria
e 9.3.3.1(Web)
e 10.3.3.1 (Non-web document)
e 11.3.3.1.1 (Open Functionality Software)
e 11.3.3.1.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)

Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

3.3.2 Labels or Instructions (Level A)
Also applies to:
EN 301 549 Criteria

Conformance Level Remarks and Explanations

Supports Context is not changed on focus alone.

Compliance of this standard was validated using manual
visual and keyboard checks.

Partially Supports Place of the error is displayed but the error is not
explained

Exceptions

Database Management

e Databased Details Edit > Coverage
dates/Custom URL errors are shown but not
explained

e Provider Details Edit > Custom URL errors are
shown but not explained

e Errors describe the problem and inform the user
where the problem occurred

e Compliance of this standard was validated using
manual checks

Partially Supports
Exceptions
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http://www.w3.org/TR/WCAG20/#consistent-behavior-unpredictable-change
http://www.w3.org/TR/WCAG20/#minimize-error-identified
http://www.w3.org/TR/WCAG20/#minimize-error-cues

Criteria

e 9.3.3.2(Web)
e 10.3.3.2 (Non-web document)
e 11.3.3.2 (Open Functionality Software)
e 11.3.3.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)

Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

4.1.1 Parsing (Level A)

Also applies to:

EN 301 549 Criteria
e 9.4.1.1(Web)
e 10.4.1.1 (Non-web document)
e 11.4.1.1.1 (Open Functionality Software)

e 11.4.1.1.2 (Closed Software) — Does not apply

e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)

Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

4.1.2 Name, Role, Value (Level A)

Also applies to:

EN 301 549 Criteria
e 9.4.1.2 (Web)
e 10.4.1.2 (Non-web document)
e 11.4.1.2.1 (Open Functionality Software)
e 11.4.1.2.2 (Closed Software) — Not required
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)

Conformance Level

Supports

Partially Supports

Page 17 of 40

Remarks and Explanations
Database Management

e Databased Details Edit and Provider Details Edit
screens have unlabeled controls

See 1.1.1 Non-text Content (Level A)

Compliance of this standard was validated using a
combination of screen readers and manual keyboard
and visual checks.

Pages conform to HTML web standards.

Compliance of this standard was validated using WAVE
and developer tools.

Pages conform to HTML web standards, so the name
and role of all Ul components can be determined.

Compliance of this standard was validated using WAVE
and manual visual checks.

Exceptions

Database Management



http://www.w3.org/TR/WCAG20/#ensure-compat-parses
http://www.w3.org/TR/WCAG20/#ensure-compat-rsv

e 12.2.4 (Support Docs) e Databased Details Edit and Provider Details Edit
Revised Section 508 screens have unlabeled controls

e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
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Table 2: Success Criteria, Level AA

Notes:

Criteria
1.2.4 Captions (Live) (Level AA)
Also applies to:
EN 301 549 Criteria
e 9.1.2.4(Web)
e 10.1.2.4 (Non-web document)
e 11.1.2.4 (Open Functionality Software)
e 11.1.2.4 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
1.2.5 Audio Description (Prerecorded) (Level AA)
Also applies to:
EN 301 549 Criteria
e 9.1.2.5(Web)
e 10.1.2.5 (Non-web document)
e 11.1.2.5 (Open Functionality Software)
e 11.1.2.5(Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

Conformance Level

Not Applicable

Not Applicable
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Remarks and Explanations
The product does not contain live audio or video
content.

This standard was evaluated using manual visual checks.

The product does not contain video content.

This standard was evaluated using manual visual checks.


http://www.w3.org/TR/WCAG20/#media-equiv-real-time-captions
http://www.w3.org/TR/WCAG20/#media-equiv-audio-desc-only

Criteria Conformance Level Remarks and Explanations
1.3.4 Orientation (Level AA 2.1 only) Does Not Support Right edge of user interface is cut off when displayed in

Also applies to: portrait orientation.
EN 301 549 Criteria

e 9.1.3.4 (Web)

e 10.1.3.4 (Non-web document)

e 11.1.3.4 (Open Functionality Software)

e 11.1.3.4 (Closed Software)

e 11.8.2 (Authoring Tool)

e 12.1.2 (Product Docs)

e 12.2.4 (Support Docs)
Revised Section 508 — Does not apply

1.3.5 Identify Input Purpose (Level AA 2.1 only) Not Applicable No form inputs collecting information about the user
Also applies to: are present in Management Tools and subsections,
EN 301 549 Criteria Overlap Analysis or Management Reports.

e 9.1.3.5(Web)
e 10.1.3.5 (Non-web document)
e 11.1.3.5.1 (Open Functionality Software)
e 11.1.3.5.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508 — Does not apply

Page 20 of 40


https://www.w3.org/TR/WCAG21/#orientation
https://www.w3.org/TR/WCAG21/#identify-input-purpose

Criteria Conformance Level

1.4.3 Contrast (Minimum) (Level AA) Supports
Also applies to:
EN 301 549 Criteria
e 9.1.4.3 (Web)
e 10.1.4.3 (Non-web document)
e 11.1.4.3 (Open Functionality Software)
e 11.1.4.3 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
1.4.4 Resize text (Level AA) Supports
Also applies to:
EN 301 549 Criteria
e 9.1.4.4(Web)
e 10.1.4.4 (Non-web document)
e 11.1.4.4.1 (Open Functionality Software)
e 11.1.4.4.2 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

Page 21 of 40

Remarks and Explanations
All elements meet level AA contrast minimums

This standard was evaluated using WAVE plugin.

Text can be resized without assistive technology up to
200 percent without loss of content or functionality.

This standard has been evaluated using browser resize
controls.


http://www.w3.org/TR/WCAG20/#visual-audio-contrast-contrast
http://www.w3.org/TR/WCAG20/#visual-audio-contrast-scale

Criteria

1.4.5 Images of Text (Level AA)

Also applies to:
EN 301 549 Criteria
e 9.1.4.5 (Web)
e 10.1.4.5 (Non-web document)
e 11.1.4.5.1 (Open Functionality Software)
e 11.1.4.5.2 (Closed Software) — Does not apply
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

1.4.10 Reflow (Level AA 2.1 only)

Also applies to:
EN 301 549 Criteria
e 9.1.4.10 (Web)
e 10.1.4.10 (Non-web document)
e 11.1.4.10 (Open Functionality Software)
e 11.1.4.10 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508 — Does not apply

Conformance Level
Not Applicable

Does Not Support
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Remarks and Explanations
There are no images of text.

Pages do not reflow.


http://www.w3.org/TR/WCAG20/#visual-audio-contrast-text-presentation
https://www.w3.org/TR/WCAG21/#reflow

Criteria

1.4.11 Non-text Contrast (Level AA 2.1 only)
Also applies to:
EN 301 549 Criteria
e 9.1.4.11 (Web)
e 10.1.4.11 (Non-web document)
e 11.1.4.11 (Open Functionality Software)
e 11.1.4.11 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508 — Does not apply

Conformance Level Remarks and Explanations
Partially Supports Non-text content, such as icons, meets minimum
standards of 3:1 color contrast ratio with the
surrounding background.

Exceptions:

Management Tools

e Sticky note/add icons

e Buttons- Create New Database, Edit Status,
Show All, pagination icons

e Data Management>New Library Specific
Database "Save" and "Cancel" buttons

e Data Management>Show All "Show 25 per
Page" button

Knowledgebase Notifications
e Buttons- “New Providers and Databases” and
“Edit”
e Check boxes
e Helpicon

Overlap Analysis
e Buttons- “Edit Default List,” “Reset,” “Add,”
“Remove, Run Analysis”
e Helpicon

. x" icon in "Default status list" modal

Management Reports
e Buttons- “Update List” and “Request Report”
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https://www.w3.org/TR/WCAG21/#non-text-contrast

Criteria Conformance Level Remarks and Explanations

1.4.12 Text Spacing (Level AA 2.1 only) Supports Most text on the site is styled without any fixed heights
Also applies to: or widths and most text in containers have containers
EN 301 549 Criteria that grow with them and do not overlap other
e 9.1.4.12 (Web) containers.
e 10.1.4.12 (Non-web document)
e 11.1.4.12 (Open Functionality Software) This standard was evaluated using manual visual checks.

e 11.1.4.12 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508 — Does not apply
1.4.13 Content on Hover or Focus (Level AA 2.1 only) Not Applicable Not content appears on hover or focus.
Also applies to:
EN 301 549 Criteria
e 9.1.4.13 (Web)
e 10.1.4.13 (Non-web document)
e 11.1.4.13 (Open Functionality Software)
e 11.1.4.13 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508 — Does not apply
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https://www.w3.org/TR/WCAG21/#text-spacing
https://www.w3.org/TR/WCAG21/#content-on-hover-or-focus

Criteria Conformance Level Remarks and Explanations

2.4.5 Multiple Ways (Level AA) Does Not Support There is no sitemap
Also applies to: Most pages have a single navigation path to them
EN 301 549 Criteria
e 9.24.5(Web) This standard has been evaluated using manual and
e 10.2.4.5 (Non-web document) — Does not apply visual checks.
e 11.2.4.5(Open Functionality Software) — Does not apply
e 11.2.4.5 (Closed Software) — Does not apply Data Management — doesn’t support

e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software) — Does not apply to non-web software
e 504.2 (Authoring Tool)
e 602.3 (Support Docs) — Does not apply to non-web docs

2.4.6 Headings and Labels (Level AA) Partially Supports Descriptive headings and labels have been used

Also applies to: throughout the interface.

EN 301 549 Criteria
e 9.2.4.6(Web) Exceptions
e 10.2.4.6 (Non-web document) See 1.3.1 Info and Relationships (Level A)
e 11.2.4.6 (Open Functionality Software)
e 11.2.4.6 (Closed Software) 3.3.2 Labels or Instructions (Level A)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs) Compliance of this standard was validated using WAVE
e 12.2.4 (Support Docs) and manual visual checks.

Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
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http://www.w3.org/TR/WCAG20/#navigation-mechanisms-mult-loc
http://www.w3.org/TR/WCAG20/#navigation-mechanisms-descriptive

Criteria
2.4.7 Focus Visible (Level AA)
Also applies to:
EN 301 549 Criteria
e 9.24.7 (Web)
e 10.2.4.7 (Non-web document)
e 11.2.4.7 (Open Functionality Software)
e 11.2.4.7 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
3.1.2 Language of Parts (Level AA)
Also applies to:
EN 301 549 Criteria
e 9.3.1.2(Web)
e 10.3.1.2 (Non-web document)

e 11.3.1.2 (Open Functionality Software) — Does not apply
e 11.3.1.2 (Closed Software) — Does not apply

e 11.8.2 (Authoring Tool)

e 12.1.2 (Product Docs)

e 12.2.4 (Support Docs)
Revised Section 508

e 501 (Web)(Software)

e 504.2 (Authoring Tool)

e 602.3 (Support Docs)

Conformance Level
Supports

Not Applicable
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Remarks and Explanations
The site has been implemented to support the default
focus indicator for the device being used.

In addition, most link text and other elements have
been styled to change in visual appearance when the
mouse hovers or tabs over them.

For instance, on mouse hover, links are underlined. On
tab focus, links are underlined and display a blue
outline. Form input fields display with a heavier border
on focus.

There is no non-English content.


http://www.w3.org/TR/WCAG20/#navigation-mechanisms-focus-visible
http://www.w3.org/TR/WCAG20/#meaning-other-lang-id

Criteria Conformance Level
3.2.3 Consistent Navigation (Level AA) Supports
Also applies to:
EN 301 549 Criteria
e 9.3.2.3(Web)
e 10.3.2.3 (Non-web document) — Does not apply
e 11.3.2.3 (Open Functionality Software) — Does not apply
e 11.3.2.3 (Closed Software) — Does not apply
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software) — Does not apply to non-web software
e 504.2 (Authoring Tool)
e 602.3 (Support Docs) — Does not apply to non-web docs
3.2.4 Consistent Identification (Level AA) Supports
Also applies to:
EN 301 549 Criteria
e 9.3.2.4(Web)
e 10.3.2.4 (Non-web document) — Does not apply
e 11.3.2.4 (Open Functionality Software) — Does not apply
e 11.3.2.4 (Closed Software) — Does not apply
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software) — Does not apply to non-web software
e 504.2 (Authoring Tool)
e 602.3 (Support Docs) — Does not apply to non-web docs
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Remarks and Explanations
The primary site navigation links appear in the same
place and the same order on every page of the site.

Compliance of this standard was validated using a
combination of screen readers, manual keyboard and
visual checks.

Care has been taken to identify components with the
same functionality consistently throughout the site.

Compliance of this standard was validated using a
combination of screen readers and manual keyboard
and visual checks.


http://www.w3.org/TR/WCAG20/#consistent-behavior-consistent-locations
http://www.w3.org/TR/WCAG20/#consistent-behavior-consistent-functionality

Criteria
3.3.3 Error Suggestion (Level AA)
Also applies to:
EN 301 549 Criteria
e 9.3.3.3(Web)
e 10.3.3.3 (Non-web document)
e 11.3.3.3 (Open Functionality Software)
e 11.3.3.3 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)
3.3.4 Error Prevention (Legal, Financial, Data) (Level AA)
Also applies to:
EN 301 549 Criteria
e 9.3.3.4(Web)
e 10.3.3.4 (Non-web document)
e 11.3.3.4 (Open Functionality Software)
e 11.3.3.4 (Closed Software)
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508
e 501 (Web)(Software)
e 504.2 (Authoring Tool)
e 602.3 (Support Docs)

Conformance Level
Does Not Support

Not Applicable
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Remarks and Explanations
Error placement is identified but error details are not
provided
See 3.3.1 Error Identification (Level A)

The site doesn’t contain content that causes legal
commitments or financial transactions for the user.


http://www.w3.org/TR/WCAG20/#minimize-error-suggestions
http://www.w3.org/TR/WCAG20/#minimize-error-reversible

Criteria
4.1.3 Status Messages (Level AA 2.1 only)
Also applies to:
EN 301 549 Criteria
e 9.4.1.3(Web)
e 10.4.1.3 (Non-web document)
e 11.4.1.3 (Open Functionality Software)
e 11.4.1.3 (Closed Software) — Does not apply
e 11.8.2 (Authoring Tool)
e 12.1.2 (Product Docs)
e 12.2.4 (Support Docs)
Revised Section 508 — Does not apply

Conformance Level
Does Not Support
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Remarks and Explanations
In the areas of Data Management, Knowledgebase
Notifications, Overlap Analysis, Management Reports
role= “status” is missing from status messages that
appear on the screen making them unread by screen
readers.


https://www.w3.org/TR/WCAG21/#status-messages

Revised Section 508 Report

Notes:

Chapter 3: Functional Performance Criteria (FPC)

Notes:

Criteria Conformance Level
302.1 Without Vision Supports with exceptions
302.2 With Limited Vision Supports
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Remarks and Explanations
This product is coded to work with screen
readers and other assistive technologies.

Exceptions
In a cases proper labeling is not provided,
see 1.3.1 Info and Relationships (Level A)

3.3.2 Labels or Instructions (Level A)

4.1.3 Status Messages (Level AA)

Compliance of this standard was validated
using screen readers (listed above) and
manual keyboard checks.

This product is coded to work with screen
readers and other assistive technologies.
In addition, text size can be adjusted
through standard browser functionality.

Compliance of this standard was validated
using screen readers (listed above), visual,
and manual keyboard checks.


https://www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-ict-refresh/final-rule/text-of-the-standards-and-guidelines#302-functional-performance-criteria

Criteria
302.3 Without Perception of Color

302.4 Without Hearing

302.5 With Limited Hearing

302.6 Without Speech

Conformance Level
Supports

Support

Support

Support
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Remarks and Explanations
Color is used to enhance usability by
drawing attention to certain areas of the
screen. Color is never the only means of
conveying information, indicating an
action, prompting a response, or
distinguishing a visual element.

Compliance of this standard was validated
using manual visual checks.

This product does not contain any audio
output and does not require any audio
input. User hearing is not required to
search, browse, or use features that are
available in the product.

This standard was evaluated using manual
visual checks.

This product does not contain any audio
output and does not require any audio
input. User hearing is not required to
search, browse, or use features that are
available in the product.

This standard was evaluated using manual
visual checks.

User speech is not required to use the
product. Compliance of this standard was
validated using manual visual checks.



Criteria
302.7 With Limited Manipulation

302.8 With Limited Reach and Strength

302.9 With Limited Language, Cognitive, and Learning Abilities

Chapter 5: Software

Notes:

Conformance Level
Partially Supports

Partially Supports

Does Not Support
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Remarks and Explanations
Most screen elements are designed to be
accessible for users with poor motor
control (e.g., clickable areas are suitably
sized and spaced). Links and form
elements can be accessed using the tab
key.

Exceptions
See 2.1.1 Keyboard (Level A)

Compliance of this standard was validated
using manual keyboard and visual checks.
At least one mode of operation that is
operable with limited reach and limited
strength.

For example:

® The product can be used using keyboard
only.

» All active elements can receive keyboard
focus.

* The focus order of form fields is
presented in a logical order.

Compliance of this standard was validated
using manual keyboard and visual checks.

Exceptions
See 2.1.1 Keyboard (Level A)



https://www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-ict-refresh/final-rule/text-of-the-standards-and-guidelines#501-general

Criteria
501.1 Scope — Incorporation of WCAG 2.0 AA
502 Interoperability with Assistive Technology
502.2.1 User Control of Accessibility Features

502.2.2 No Disruption of Accessibility Features

502.3 Accessibility Services
502.3.1 Object Information

Conformance Level
See WCAG 2.x section
Heading cell — no response required
Supports

Supports

Heading cell — no response required
Supports
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Remarks and Explanations
See information in WCAG 2.x section
Heading cell — no response required
This product does not interfere with
accessibility features that are available
through the user’s operating system or
browser. For example, users can use high
contrast mode, text resize, and speech
output.

Compliance of this standard was validated
using manual checks.

This product does not disrupt accessibility
features that are defined in the platform
documentation as accessibility features.

Compliance of this standard was validated
through manual checks.

Heading cell — no response required
Attributes for role, state/s, boundary,
name and other properties for all standard
and custom user interface controls are
programmatically determinable.
Compliance of this standard was validated
using screen readers (listed above) and
developer tools.


https://www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-ict-refresh/final-rule/text-of-the-standards-and-guidelines#502-interoperability-assistive-technology

Criteria
502.3.2 Modification of Object Information

502.3.3 Row, Column, and Headers

Conformance Level
Partially Supports

Supports
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Remarks and Explanations
States and properties that can be set by
the user are capable of being set
programmatically, including through
assistive technology. For example, users
are able to change focus and expand and
collapse panels using a keyboard only. The
state of the object is announced through
assistive technology.

Exceptions
See 2.5.3 Label in Name (Level A)

Compliance of this standard was validated
using screen readers (listed above) and
keyboard checks.

Tables are implemented using standard
html elements, row and a column header
are marked and can be identified as tables
programmatically.

This standard was evaluated using manual
visual checks and code inspection.



502.3.4 Values

502.3.5 Modification of Values

Criteria

Conformance Level
Partially Supports

Supports
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Remarks and Explanations
The current values available for a user
input control can be programmatically
determined. For example, a screen reader
will read out the values in a drop-down
menu, checkbox options, and radio
buttons.

Exceptions
See 1.3.1 Info and Relationships (Level A),

3.3.2 Labels or Instructions (Level A)

Compliance of this standard was validated
using screen readers (listed above) and
keyboard checks.

Values that can be set by the user can be
set programmatically, including through
assistive technology. Compliance of this
standard was validated using screen
readers (listed above) and keyboard
checks.



Criteria
502.3.6 Label Relationships

502.3.7 Hierarchical Relationships

502.3.8 Text

Conformance Level
Supports with exceptions

Supports

Supports
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Remarks and Explanations
All forms have been coded with the
necessary mark-up (e.g., using labels / ids,
fieldsets, etc.) to make them accessible to
assistive technologies. Text labels identify
all form fields. Label / ids and other
accessible code necessary for screen
readers are associated with all form
elements.
Exceptions

See 1.3.1 Info and Relationships (Level A)

3.3.2 Labels or Instructions (Level A),

2.5.3 Label in Name (Level A)

Compliance of this standard was validated
using WAVE and manual visual checks.

Hierarchical (parent-child) relationships
are programmatically determinable. For
example, when tabbing to a dropdown,
assistive technology will announce how
many items it contains.

Compliance of this standard was validated
using screen readers (listed above) and
manual checks.

Standard HTML code is used for displaying
text on the screen used. Text styling is
controlled through cascading style sheets.

Compliance of this standard was validated
using manual visual checks.



Criteria
502.3.9 Modification of Text

502.3.10 List of Actions

502.3.11 Actions on Objects

502.3.12 Focus Cursor

Conformance Level
Supports

Supports

Supports

Supports
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Remarks and Explanations
The product is primarily static text; it does
not allow users to set attributes of the
text. Users are able to insert text into
search fields and forms. This text can be
modified using assistive technology.

Compliance of this standard was validated
using manual visual checks.

Where relevant, the product’s Ul
components provide a list of actions
programmatically determinable by
assistive technologies.

Compliance of this standard was validated
using screen readers (listed above) and
manual keyboard checks.

This product is coded in a way to allow
assistive technologies (AT) to
programmatically execute available
actions on objects.

Compliance of this standard was validated
with using screen readers (listed above)
and manual keyboard checks.

The current input focus can be discerned
by assistive technology (using standard
html code for forms, etc.). For most page
elements, cursor focus is indicated visually
by a blue border.

This standard was evaluated using manual
keyboard and visual checks.



Criteria
502.3.13 Modification of Focus Cursor

502.3.14 Event Notification

502.4 Platform Accessibility Features

503 Applications

Conformance Level
Supports

Does Not Support

Supports

Heading cell — no response required

Page 38 of 40

Remarks and Explanations
Users are able to modify the location of
focus (for user focusable controls), the
text insertion point (caret) when a caret
exists, and change selection attributes of
objects (when text and items can be
selected by the user).

This standard was evaluated using manual
keyboard and visual checks.

When data on the page is refreshed based
on user action (e.g. Filter databases by
name, Search databases), user is not
notified about the newly displayed
content.

See 4.1.3 Status Messages (Level AA)

This standard was evaluated using screen
readers (listed above).

The product does not interfere with
system features to:

¢ Enable sequential entry of multiple
(chorded) keystrokes (Section 9.3.3) e
Provide adjustment of delay before key
acceptance (Section 9.3.4)

* Provide adjustment of same-key double-
strike acceptance (Section 9.3.5)

® Provide screen reader support. In
addition, a text-to-speech feature is
available on document pages. It is an
optional feature that can be enabled in the
customer’s account. (Section 10.6.9)

Heading cell — no response required


https://www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-ict-refresh/final-rule/text-of-the-standards-and-guidelines#503-applications

Criteria Conformance Level

503.2 User Preferences Supports
503.3 Alternative User Interfaces Not applicable
503.4 User Controls for Captions and Audio Description Heading cell — no response required
503.4.1 Caption Controls Not applicable
503.4.2 Audio Description Controls Not applicable
504 Authoring Tools Heading cell — no response required
504.? ConEent Creation or Editing (if not authoring tool, enter “not See WCAG 2.x section
applicable”) —
504.2.1 Preservation of Information Provided for Accessibility in Format .
. Not applicable
Conversion
504.2.2 PDF Export Not applicable
504.3 Prompts Not applicable
504.4 Templates Not applicable

Chapter 6: Support Documentation and Services

Notes:

Criteria Conformance Level
601.1 Scope Heading cell — no response required
602 Support Documentation Heading cell — no response required
602.2 Accessibility and Compatibility Features Not Supported
602.3 Electronic Support Documentation See WCAG 2.x section
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Remarks and Explanations
The CSS style sheet can be overridden in
the product using the browser settings.

Compliance of this standard was validated
using manual visual checks.

This product does not provide alternative
user interfaces that function as assistive
technology. This standard was evaluated
using manual visual checks.

Heading cell — no response required

This product does not contain any
audio/video content

This product does not contain any
audio/video content

Heading cell — no response required

See information in WCAG 2.x section

Not applicable

Not applicable
Not applicable
Not applicable

Remarks and Explanations
Heading cell — no response required
Heading cell — no response required

Accessibility information is not available
online

See information in WCAG 2.x section


https://www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-ict-refresh/final-rule/text-of-the-standards-and-guidelines#504-authoring-tools
https://www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-ict-refresh/final-rule/text-of-the-standards-and-guidelines#601-general
https://www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-ict-refresh/final-rule/text-of-the-standards-and-guidelines#602-support-documentation

Criteria Conformance Level Remarks and Explanations

602.4 Alternate Formats for Non-Electronic Support Documentation Supports Product support documentation is
provided online through the product’s
help system and through ExLibris
Knowledge Center site. This
documentation can be accessed online or
printed. End-users can also contact
customer support (by phone, email, chat,
or through the Contact Us web form) to
request any further help.

603 Support Services Heading cell — no response required Heading cell — no response required

603.2 Information on Accessibility and Compatibility Features Not Supported Accessibility information is not available
online.

603.3 Accommodation of Communication Needs Supports Support services are available to

accommodate the communication needs
of end users with disabilities. Users can
communicate with customer support via:
* Phone

¢ Email

e Chat

¢ Contact Us web form Support services
have experience working with end users
with disabilities.

Legal Disclaimer (ProQuest)

This Accessibility Conformance Report represents the specific release of the product described, as of the date of this document. Notwithstanding the
information contained in the Accessibility Conformance Report, if use of the product is subject to a license agreement, the terms and conditions of the product’s
license agreement remain in full force and effect, including any limitation of liability and disclaimer of warranties provisions.
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